COMPUTER APPLICATION

1. MULTIMEDIA AND DESKTOP PUBLISHING

Section – A

Choose the best answer (1 Mark)

1. ________ refers to any type of application that involves more than one type of media such as text, graphics video animation and sound.
   a) an executable file  b) desktop publishing  c) multimedia  d) hypertext

2. One of the disadvantages of the multimedia is its __
   a) cost  b) adaptability  c) usability  d) relativity

3. Expand JPEG
   a) joint photo experts gross  b) joint photographic experts group
   c) joint processor experts group  d) joint photographic expression group

4. You need hardware, software and __to make multimedia
   a) network  b) compact disk drive  c) good idea  d) programming knowledge

5. Match the following by choosing the right one

   1. Text – TGA
   2. Image – MIDI
   3. Sound – MPEG
   4. Video – RTF

   a. 1, 2, 3, 4  b. 2, 3, 4, 1  c. 4, 1, 2, 3  d. 3, 4, 1, 2

6. Find the odd one on the following which is not an image format
   a) TIFF  b) BMP  c) RTF  d) JPEG

7. ____ is the process displaying still images they give continuous movement
   a) Text formats  b) Sound  c) MP3  d) Animation

8. The live telecasting of real time program through Internet is known as ____
   a) web casting  b) web hosting  c) data manipulation  d) none of the above

9. GIF use ________ color look up table
   a) 8 bit  b) 8 KB  c) 8 MB  d) 8 GB

10. RTF file format was introduced by______
    a) TCS  b) Microsoft  c) Apple  d) IBM
Section-B

Answer the following questions (2 Marks)

1. Define Multimedia and their features.
   - The term multimedia comprises of two words, “multi” and “medium”.
   - Multi → Many and Media → Medium.
   - Multimedia is an integration of many types of media like text, graphics, images, audio, animation, and video etc on a single medium in the same information unit.

2. List out Multimedia Components
   - Multimedia has five major components like text, images, sound, video and animation.

![Multimedia Components Diagram]

3. Classify the TEXT component in multimedia.
   - Text is classified as static and dynamic text.
     1) Static Text
        - Static text, the text or the words will remain static as a heading or in a line, or in a paragraph.
     2) Hypertext
        - Hypertext is text which contains links to other texts.
        - A hypertext is a system which consists of nodes, the text and the links between the nodes, which defines the paths for accessing the text in non-sequential ways.

4. Classify the IMAGE component in multimedia
   - Images are generated by the computer in two ways, as bitmap or raster images and as vector images.
     1) Raster or Bitmap Images
        - The common and comprehensive form of storing images in a computer is raster or bitmap image.
     2) Vector Images
        - Drawing elements or objects such as lines, rectangles, circles and so on to create an image are based on Vector images.

5. Define Animation and their features
   - Animation is the process displaying still images so quickly so that they give the impression of continuous movement.
   - Animations may be in two or three dimensional.
     - Two dimensional animation occurs on the flat X and Y axis of the screen.
     - Three dimensional animation occurs along the three axis X, Y and Z.
6. List out image file formats
   1. TIFF (Tagged Image File Format)
   2. BMP (Bitmap)
   3. DIB (Device Independent Bitmap)
   4. GIF (Graphics Interchange Format)
   5. JPEG (Joint Photographic Experts Group)
   6. TGA (Tagra)
   7. PNG (Portable Network Graphics)

7. List out audio file formats
   1. WAV (Waveform Audio File Format)
   2. MP3 (MPEG Layer-3 Format)
   3. OGG
   4. AIFF (Audio Interchange File Format)
   5. WMA (Windows Media Audio)
   6. RA (Real Audio Format)

8. List out video file formats
   1. AVI (Audio/Video Interleave)
   2. MPEG (Moving Picture Experts Group)
   3. WMV (Windows Media Video)
   4. 3GP
   5. FLV (Flash Video)

   • In the multimedia application, after the pre-production activities, the production phase starts. This phase includes the activities like background music selection, sound recording and so on.
   • Text is incorporated using OCR software, Pictures shot by digital camera, Video clips are shot, edited and compressed.

10. List out Multimedia Production team members
    • The Multimedia Production team comprises of members like Script writer, Production manager, Editor, Graphics Architect, Multimedia Architect, Programmer, and Web Master.
Section-C

Answer the following questions (3 Marks)

1. Briefly explain about Multimedia Components.

MULTIMEDIA COMPONENTS:

1) Text
   - Text is the basic components of multimedia most commonly used for communication.
     - Static Text, Hypertext

2) Image
   - Images acts as an vital component in multimedia that are generated in two ways,
     - Bitmap or Raster images, Vector images.

3) Animation
   - Animation is the process of displaying still images so quickly so that they give the impression of
     continuous movement.
     - Path Animation, Frame Animation

4) Sound
   - Sound is a meaningful speech in any language and providing the pleasure of music, special effects
     and so on.
     - MIDI, Digital Audio

5) Video
   - Video is defined as the display of recorded event, scene etc. The powerful way to convey
     information in multimedia applications are embedding of video
     - Analog Video

2. Describe the features and techniques of animation

   - Animation is the process displaying still images so quickly so that they give the impression of
     continuous movement.
   - The least frame rate of at least 16 frames per second gives the impression of smoothness
   - Natural looking should be at least 25 frames per second.
   - Animations may be in two or three dimensional.
     - Two dimensional animation occurs on the flat X and Y axis of the screen.
     - Three dimensional animation occurs along the three axis X, Y and Z.
   - The two basic types of animations are,
     - Path animation involves moving an object on a screen that has a constant background
     - In frame animations, multiple objects are allowed to travel simultaneously and the background or
       the objects also changes.
3. Write roles and responsibilities of Production team members

1. Production Manager
   - In a multimedia production, the role of production manager is to define, and coordinate, the production of the multimedia project in time and with full quality.

2. Content Specialist
   - Content specialist is responsible for performing all research activities concerned with the proposed application’s content.

3. Script Writer
   - The script writer visualizes the concepts in three dimensional environments

4. Text Editor
   - The Text Editor checks the flow of text, structure and correct it grammatically.

5. Multimedia Architect
   - The multimedia architect integrates all the multimedia building blocks using an authoring tools.

4. Describe the various file formats in multimedia

1. Text File Formats
   - RTF (Rich Text Format)
   - Plain text

2. Image File Formats
   - TIFF (Tagged Image File Format)
   - BMP (Bitmap)
   - DIB (Device Independent Bitmap)
   - GIF (Graphics Interchange Format)
   - JPEG (Joint Photographic Experts Group)
   - TGA (Tagra)
   - PNG (Portable Network Graphics)

3. Digital Audio File Formats
   - WAV (Waveform Audio File Format)
   - MP3 (MPEG Layer-3 Format)
   - OGG
   - AIFF (Audio Interchange File Format)
   - WMA (Windows Media Audio)
   - RA (Real Audio Format)

4. Digital Video File Formats
   - AVI (Audio/Video Interleave)
   - WMV (Windows Media Video)
   - FLV (Flash Video)
   - 3GP
   - MPEG (Moving Picture Experts Group)

5. Explain animation industry and their scope
   - Indian animation industry is anticipated to grow faster than the IT industry.
   - The industry has grown to a multibillion net worth standard.
• The manpower crunch needs to be decreased with animators.
• There are hundreds and thousands of job opportunities lying around open for animators.
• Work opportunities for quality animators and related professionals exist in the following sectors :-
  - Advertising
  - Online and Print News Media
  - Film & Television
  - Cartoon production
  - Theater
  - Video Gaming
  - E-learning

Section - D

Answer the following questions: (5 Marks)

The phases for development of complex multimedia projects are,

1. Conceptual Analysis and Planning:
   ▪ Conceptual analysis identifies a appropriate theme, budget and content availability on that selected theme.
   ▪ Copyright issues also are considered in this phase.

2. Project design:
   ▪ Once the theme is finalized objectives, goals, and activities are drawn for the multimedia project.
   ▪ General statements ——> Goals.
   ▪ Specific statements ——> Objectives.
   ▪ Activities are series of actions which contribute to the Project design phase.

3. Pre-production:
   Based on the planning and design the project is developed.

STEPS IN PRE-PRODUCTION:

- **Budgeting** for each phases like consultants, hardware, software, travel, communication and publishing is estimated for all the multimedia projects.
- **Multimedia Production Team** comprises of members playing various roles and responsibilities like Script writer, Production manager, Editor, Graphics Architect, Multimedia Architect and Web Master.
- **Hardware Selection** includes the selection of fastest CPU, RAM and huge monitors, sufficient disc for storing the records.
- **Software Selection and File Formats** depends on the funds available for the project.
- **Defining the Content** is the “stuff ” provided by content specialist to the multimedia architect
- **Preparing the structure:**
  - A detailed structure must have information about all the steps.
  - This structure defines the activities, responsible person and the start/end time for each activity.
4. Production:
   - In the multimedia application, after the pre-production activities, the production phase starts.
   - This phase includes the activities like background music selection, sound recording and so on.
   - A pilot project is ready by this time.

5. Testing:
   - The complete testing of the pilot product is done before the mass production to ensure that everything is right, and avoiding the failure after launch.
   - It is tested using different browsers, and deployed in the server if it is a local multimedia.
   - After the testing process are over, the product is incorporated with valid suggested changes.

6. Documentation:
   - User documentation is a mandatory feature of all multimedia projects.
   - The documentation has all the valuable information’s starting from the system requirement till the completion of testing.

7. Delivering the Multimedia Product: Are best delivered on CD/DVD or in the website.

2. Explain in detail Techniques of Animation
   - **Animation** is the process displaying still images so quickly so that they give the impression of continuous movement.
   - In animation the **screen object is a vector image** in animation.
   - Using numerical transformations the movement of that image along its paths is calculated for their defining coordinates.
   - The least frame rate of **at least 16 frames per second** gives the impression of smoothness.
   - Natural looking should be at least **25 frames per second**.
   - Animation tools are very powerful and effective.
   - Animations may be in **two or three dimensional**.
     - **Two dimensional** animation , bring an image alive, occurs on the flat **X and Y axis** of the screen.
     - **Three dimensional** animation occurs along the **three axis X, Y and Z**.
   - The two basic **types of animations** are,
     - **Path animation** involves moving an object on a screen that has a constant background.
       - **Example**: A cartoon character may move across the screen regardless of any change in the background or the character.
     - **In frame animations**, multiple objects are allowed to travel simultaneously and the background or the objects also changes.
3. Explore the opportunities in Animation filed movie industry.
   - In the past, students that complete an animation course or a visual effects course could find job opportunities only in the film industry.
   - In India, the VFX domain, or the animation and visual effects industry, has been growing stronger and stronger in recent years.
   - This is because they have become part and parcel of the media and entertainment industry, including the mobile segment, as they help to re-enact accidents in television news programmes or replay the last over in a live cricket match.
   - Animation and visual effects requirements for massive international projects such as HBO’s top TV series and Marvel’s hits Infinity War and Black Panther was outsourced to Indian companies in Mumbai and Pune.
   - The surge in demand for animation and visual effects experts has led to a significant increase in the number of students enrolling for a VFX course.
   - According to a FICCI-EY 2018 report, India’s animation and VFX industry is currently worth approximately Rs. 80 billion and is expected to reach Rs. 114 billion over the next couple of years, making it the Media and Entertainment sectors’ third most prospective vertical.
   - As such, a student that completes a 3D animation course can hope to build a rewarding and satisfying career in the Media and Entertainment field these days.
   - A number of job opportunities are opening up on a daily basis and the aim of this article is to provide some information about the various sectors that are currently hiring animation and visual effects professionals.

4. Explain in detail about production team Roles and Responsibilities
   1. Production Manager
      - The role of production manager is to define, and coordinate, the production of the multimedia project in time and with full quality.
      - The production manager should be an expertise in the technology, good at proposal writing, good communication skills and budget management skills.
   2. Content Specialist
      - Content specialist is responsible for performing all research activities concerned with the proposed application’s content.
   3. Script Writer
      - The script writer visualizes the concepts in three dimensional environments and if needed uses the virtual reality integration into the program.
   4. Text Editor
      - The content of a multimedia production always must flow logically and the text should always be structured and correct grammatically.
5. Multimedia Architect
   • The multimedia architect integrates all the multimedia building blocks like graphics, text, audio, music, video, photos and animation by using an authoring software.

6. Computer Graphic Artist
   • Computer Graphic Artist deals with the graphic elements of the programs like backgrounds, bullets, buttons, pictures editing, 3-D objects, animation, and logos etc.

7. Audio and Video Specialist
   • Audio and Video Specialist are needed for dealing with narration and digitized videos to be added in a multimedia presentation.
   • They are responsible for recording, editing sound effects and digitizing.

8. Computer Programmer
   • The computer programmer writes the lines of code or scripts in the appropriate language.
   • These scripts usually develops special functions like developing the software to give the size and shape of video windows controlling peripherals and so on.

9. Web Master
   • The responsibility of the web master is to create and maintain an Internet web page.
   • They converts a multimedia presentation into a web page.
   • Final multimedia product is ready for consultation is a joint effort of the entire team.

5. Explain about different file formats in multimedia files

1. Text File Formats
   • RTF (Rich Text Format)
     Rich Text Format is the primary file format introduced in 1987 by Microsoft
   • Plain text
     Plain text files can be opened, read, and edited with most text editors.

2. Image File Formats
   • TIFF (Tagged Image File Format)
     ➢ This format is common in desktop publishing world (high quality output)
     ➢ Supported by almost all software packages.
     ➢ Recent versions of TIFF allows image compression
     ➢ This format is comfortable for moving large files between computers.
       • BMP (Bitmap)
         ➢ BMP is used for the high-resolution or large images.
• **DIB (Device Independent Bitmap)**
  - Allows the files to be displayed on a variety of devices.

• **GIF (Graphics Interchange Format)**
  - GIF is a compressed image format.
  - This file format is best suitable for graphics that uses only limited colors
  - 13-bit Color look up table is used by the GIF format to identify its color values.

• **JPEG (Joint Photographic Experts Group)**
  - JPEG was designed to attain maximum image compression.
  - It uses lossy compression technique.
  - It works good with photographs, naturalistic artwork

3. **Digital Audio File Formats**
   - **AIFF (Audio Interchange File Format)**
     - A standard audio file format used by Apple which is like a WAV file for the Mac.
   - **WAV (Waveform Audio File Format)**
     - It is the most popular audio file format in windows for storing uncompressed sound files.
   - **MP3 (MPEG Layer-3 Format)**
     - MPEG Layer-3 format is the most popular format for storing and downloading music.
   - **WMA (Windows Media Audio)**
     - It is a popular windows media audio format owned by Microsoft and designed with Digital Right Management (DRM) abilities for copyright protection.
   - **RA (Real Audio Format)**
     - Real Audio format is designed for streaming audio over the Internet.

4. **Digital Video File Formats**
   - **AVI (Audio/Video Interleave)**
     - AVI is the video file format for Windows.
     - Here sound and picture elements are stored in alternate interleaved chunks in the file.
   - **MPEG (Moving Picture Experts Group)**
     - MPEG is the standards for digital video and audio compression.

**PREPARED BY**

J. BASKARAN M.Sc., B.Ed. (C.S)  
jhaskaran89@gmail.com

J. ILAKKIA  M.Sc., M.Phil., B.Ed. (C.S)  
jilakkia@gmail.com
COMPUTER APPLICATION

2. AN INTRODUCTION TO ADOBE PAGE MAKER

Choose the best answer

Section – A

1. DTP stands for ____________
   (a) Desktop Publishing (b) Desktop Publication (c) Doctor To Patient (d) Desktop Printer

2. ____________ is a DTP software.
   (a) Lotus 1-2-3 (b) PageMaker (c) Maya (d) Flash

3. Which menu contains the New option?
   (a) File menu (b) Edit menu (c) Layout menu (d) Type menu

4. In PageMaker Window, the area outside of the dark border is referred to as ____________.
   (a) page (b) pasteboard (c) blackboard (d) dashboard

5. Shortcut to close a document in PageMaker is ____________
   (a) Ctrl + A (b) Ctrl + B (c) Ctrl + C (d) Ctrl + W

6. A ____________ tool is used for magnifying the particular portion of the area.
   (a) Text tool (b) Line tool (c) Zoom tool (d) Hand tool

7. ____________ tool is used for drawing boxes.
   (a) Line (b) Ellipse (c) Rectangle (d) Text

8. Place option is present in ____________ menu.
   (a) File (b) Edit (c) Layout (d) Window

9. To select an entire document using the keyboard, press ____________
   (a) Ctrl + A (b) Ctrl + B (c) Ctrl + C (d) Ctrl + D

10. Character formatting consists of which of the following text properties?
    (a) Bold (b) Italic (c) Underline (d) All of these

11. Which tool lets you edit text?
    (a) Text tool (b) Type tool (c) Crop tool (d) Hand tool

12. Shortcut to print a document in Pagemaker is ____________
    (a) Ctrl + A (b) Ctrl + P (c) Ctrl + C (d) Ctrl + V

13. Adobe PageMaker is a page layout software.

14. Title Bar is the topmost part of the PageMaker window.

15. Scrolling is the process of moving up and down or left and right through the document window.
16. **Ellipse** tool is used to draw a circle.

17. The Insert pages option is available on clicking the **Layout** menu.

18. **Match the following.**
   
   - Cut - (i) Ctrl + Z \[\rightarrow\] Ctrl + X
   - Copy - (ii) Ctrl + V \[\rightarrow\] Ctrl + C
   - Paste - (iii) Ctrl + X \[\rightarrow\] Ctrl + V
   - Undo - (v) Ctrl + C \[\rightarrow\] Ctrl + Z

19. **Choose the odd man out.**
   i. Adobe PageMaker, QuarkXPress, Adobe InDesign, **Audacity**
   ii. File, Edit, Layout, Type, **Zip**
   iii. Pointer Tool, Line tool, **Hide Tool**, Hand Tool
   iv. Bold, Italic, **Portrait**, Underline

20. **Choose the correct statement.**
   i. (a) Text can be selected using mouse only.
      
      (b) Text can be selected using mouse or the keyboard.
   ii. (a) DTP is an abbreviation for Desktop publishing.
       
       (b) DTP is an abbreviation for Desktop publication.

21. **Choose the correct pair**
   (a) Edit and Cut (b) Edit and New (c) Undo and Copy (d) **Undo and Redo**

**Section-B**

**Answer the following questions**

(2 Marks)

1. **What is desktop publishing?**
   - Desktop publishing (abbreviated DTP) is the creation of page layouts for documents using DTP Software.

2. **Give some examples of DTP software.**
   - Popular DTP software are Adobe PageMaker, Adobe InDesign, QuarkXPress, etc.

3. **Write the steps to open PageMaker.**
   - We can open Adobe PageMaker using the command sequence,
   - **Start** → **All Programs** → Adobe → Pagemaker 7.0 → Adobe PageMaker 7.0.

4. **How do you create a New document in PageMaker?**
   To create a new document,
   1. Choose **File** > **New** in the menu bar. (or) Press **Ctrl + N** in the keyboard.
      
      ➢ Now **Document Setup dialog box** appears.
   2. Enter the appropriate settings for your new document in the Document Setup dialog box.
   3. Click on **OK**. Now a new document called **Untitled - 1** opens on the screen.
5. What is a Pasteboard in PageMaker?

- A document page is displayed within a dark border.
- The area outside of the dark border is referred to as the pasteboard.
- Data placed in the pasteboard is not visible when you print the document.
- Pasteboard is used to temporarily hold elements while designing your document.

6. Write about the Menu bar of PageMaker.

- Menu Bar contains the following menus,
  - File, Edit, Layout, Type, Element, Utilities, View, Window, Help.
- When you click on a menu item, a pulldown menu appears.
- There may be sub-menus under certain options in the pull-down menus.

7. Differentiate Ellipse tool from Ellipse frame tool.

<table>
<thead>
<tr>
<th>Ellipse tool</th>
<th></th>
<th></th>
<th>Used to draw circles and ellipses.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellipse frame tool</td>
<td></td>
<td></td>
<td>Used to create elliptical placeholders for text and graphics.</td>
</tr>
</tbody>
</table>

8. What is text editing?

- Editing means making changes to the text.
- Editing is the process of inserting and deleting words, correcting errors, moving and copying text in the document.

9. What is text block?

- In PageMaker the text of the document can be typed inside a **text block**.
- **Text tool is used** to create text blocks.
- After creating a Text block, you can type the text directly into the text block.
- You cannot see the borders of a text block until you select it with the pointer tool.

10. What is threading text blocks?

- A Text block can be connected to other text block to enable the flow of text.
- Text blocks that are connected in this way are **threaded**.
- The process of connecting text among Text blocks is called **threading text**.

11. What is threading text?

- Text blocks that are connected are said to be **threaded**.
- The process of connecting text among Text blocks is called **threading text**.
12. How do you insert a page in PageMaker?

To insert pages

1. Go to the page where you want to insert.
2. Choose \textit{Layout} > \textit{Insert Pages} in the menu bar. The \textit{Insert Pages} dialog box appears.
3. Type the number of pages you want to insert.
4. To insert pages after the current page, choose ‘after’ from the pop-up menu.
5. Click on Insert.
6. The new pages are inserted in your publication

\textbf{Section-C}

\textbf{Answer the following questions} \hspace{1cm} (3 Marks)

   - Adobe PageMaker is a \textbf{page layout software}.
   - It is used to design and produce documents that can be printed.
   - Page layout software includes tools that allow you to easily position text and graphics on document pages.
   - \textbf{Example:} Creating a newsletter that includes articles and pictures on each page using PageMaker.

2. Mention three tools in PageMaker and write their keyboard shortcuts.

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Tools</th>
<th>Keyboard Short Cut</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pointer Tool</td>
<td>F9</td>
</tr>
<tr>
<td>2</td>
<td>Rotating Tool</td>
<td>Shift + F2</td>
</tr>
<tr>
<td>3</td>
<td>Line Tool</td>
<td>Shift + F3</td>
</tr>
</tbody>
</table>

3. Write the use of any three tools in PageMaker along with symbols.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Toolbox</th>
<th>Cursor</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer Tool</td>
<td><img src="image" alt="Pointer Tool" /></td>
<td><img src="image" alt="Pointer Cursor" /></td>
<td>Used to select, move, and resize text objects and graphics.</td>
</tr>
<tr>
<td>Text tool</td>
<td><img src="image" alt="Text Tool" /></td>
<td><img src="image" alt="Text Cursor" /></td>
<td>Used to type, select, and edit text.</td>
</tr>
<tr>
<td>Rotating tool</td>
<td><img src="image" alt="Rotating Tool" /></td>
<td><img src="image" alt="Rotating Cursor" /></td>
<td>Used to select and rotate objects.</td>
</tr>
</tbody>
</table>
4. How do you rejoin split blocks?

**Rejoining Split Blocks:**

To rejoin the two text blocks,

1. Place the cursor on the bottom handle of the second text block, click and drag the bottom handle up to the top.
2. Then place the cursor on the bottom handle of the first text block, and click and drag the bottom handle down if necessary.

5. How do you link frames containing text?

- To link Frames containing text,
  1. Draw a **second frame** with the Frame tool of your choice.
  2. Click the **first frame** to select it.
  3. Click on the **red triangle** to load the text icon.
  4. Click the **second frame**.
  5. PageMaker flows the text into the second frame.

6. What is the use of Master Page?

- Any text or object that you place on the master page will appear on the entire document pages to which the master is applied.
- Master Pages commonly contain repeating logos, page numbers, headers, and footers.
- Master items cannot be selected on a document page.

7. How do you insert page numbers in Master pages?

1. Click on Master Pages icon.
2. Then click on Text Tool. Now the cursor changes to I - beam.
3. Then Click on the left Master page where you want to put the page number.
4. Press Ctrl + Alt + P.
5. The page number displays as ‘LM’ on the left master page.
6. Similarly click on the right Master page where you want to put the page number.
7. Press Ctrl + Alt + P.
8. The page number displays as ‘RM’ on the right master page, but will appear correctly on the actual pages.
Section - D

Answer the following questions: (5 Marks)

1. Explain the tools in PageMaker toolbox.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Toolbox</th>
<th>Cursor</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer Tool</td>
<td>![Pointer Tool]</td>
<td>![Pointer Cursor]</td>
<td>Used to select, move, and resize text objects and graphics.</td>
</tr>
<tr>
<td>Text tool</td>
<td>![Text Tool]</td>
<td>![Text Cursor]</td>
<td>Used to type, select, and edit text.</td>
</tr>
<tr>
<td>Rotating tool</td>
<td>![Rotating Tool]</td>
<td>![Rotating Cursor]</td>
<td>Used to select and rotate objects.</td>
</tr>
<tr>
<td>Cropping tool</td>
<td>![Cropping Tool]</td>
<td>![Cropping Cursor]</td>
<td>Used to trim imported graphics.</td>
</tr>
<tr>
<td>Line tool</td>
<td>![Line Tool]</td>
<td>![Line Cursor]</td>
<td>Used to draw straight lines in any direction.</td>
</tr>
<tr>
<td>Constrained line tool</td>
<td>![Constrained Line Tool]</td>
<td>![Constrained Line Cursor]</td>
<td>Used to draw vertical or horizontal lines.</td>
</tr>
<tr>
<td>Rectangle tool</td>
<td>![Rectangle Tool]</td>
<td>![Rectangle Cursor]</td>
<td>Used to draw squares and rectangles.</td>
</tr>
<tr>
<td>Rectangle frame tool</td>
<td>![Rectangle Frame Tool]</td>
<td>![Rectangle Frame Cursor]</td>
<td>Used to create rectangular placeholders for text and graphics.</td>
</tr>
<tr>
<td>Ellipse tool</td>
<td>![Ellipse Tool]</td>
<td>![Ellipse Cursor]</td>
<td>Used to draw circles and ellipses.</td>
</tr>
<tr>
<td>Ellipse frame tool</td>
<td>![Ellipse Frame Tool]</td>
<td>![Ellipse Frame Cursor]</td>
<td>Used to create elliptical placeholders for text and graphics.</td>
</tr>
<tr>
<td>Polygon tool</td>
<td>![Polygon Tool]</td>
<td>![Polygon Cursor]</td>
<td>Used to draw polygons.</td>
</tr>
<tr>
<td>Polygon frame tool</td>
<td>![Polygon Frame Tool]</td>
<td>![Polygon Frame Cursor]</td>
<td>Used to create polygonal placeholders for text and graphics.</td>
</tr>
<tr>
<td>Hand tool</td>
<td>![Hand Tool]</td>
<td>![Hand Cursor]</td>
<td>Used to scroll the page (an alternative to the scroll bar)</td>
</tr>
<tr>
<td>Zoom tool</td>
<td>![Zoom Tool]</td>
<td>![Zoom Cursor]</td>
<td>Used to magnify or reduce an area of the page.</td>
</tr>
</tbody>
</table>
2. Write the steps to place the text in a frame.

To place text in a Frame,

1. Click on one of a Frame tool from the Toolbox.
2. Draw a frame with one of PageMaker’s Frame tools (Rectangle frame tool or Ellipse Frame Tool or Polygon frame Tool). Make sure the object remains selected.
3. Click on File. The File menu will appear.
4. Click on Place. The Place dialog box will appear.
5. Locate the document that contains the text you want to place, select it.
6. Click on Open.
7. Click in a frame to place the text in it. The text will be placed in the frame.

3. How can you convert text in a text block to a frame?

- After created text in a text block, if you want to convert it to a frame.
- You can do this by using these steps.
  1. Draw the **frame** of your choice using one of the PageMaker’s Frame tool.
  2. Select the text block you want to insert in the frame.
  3. Click the frame while pressing the Shift key. Now both elements will be selected.
  4. Choose **Element > Frame > Attach Content** on the Menu bar.
  5. Now the text appears in the frame.

4. Write the steps to draw a star using polygon tool?

**Drawing a Star using Polygon tool**

- **To draw a Star**
  1. Click on the **Polygon tool** from the toolbox. The cursor changes to a crosshair.
  2. Click and drag anywhere on the screen. As you drag, a Polygon appears.
  3. Release the mouse button when the Polygon is of the desired size.
  4. Choose **Element > Polygon Settings** in the menu bar. Now Polygon Settings dialogue box appears.
  5. Type 5 in the Number of sides text box.
  6. Type 50% in Star inset textbox.
  7. Click OK. Now the required star appears on the screen.

**PREPARED BY**

J. BASKARAN M.Sc., B.Ed. (C.S)  
jbaskaran89@gmail.com

J. ILAKKIA  M.Sc., M.Phil., B.Ed. (C.S)  
jilakkia@gmail.com
J. BASKARAN M.Sc., B.Ed. (C.S)  
jbaskaran89@gmail.com  
Puducherry.

J. ILAKKIA  M.Sc., M.Phil., B.Ed. (C.S)  
jilakkia@gmail.com  
Puducherry.

COMPUTER APPLICATION

3. INTRODUCTION TO DATABASE MANAGEMENT SYSTEM

Choose the best answer

Section – A

(1 Marks)
1. Which language is used to request information from a Database?
   a) Relational    b) Structural    c) Query    d) Compiler
2. The --------- diagram gives a logical structure of the database graphically?
   a) Entity-Relationship  b) Entity  c) Architectural Representation  d) Database
3. An entity set that does not have enough attributes to form primary key is known as
   a) Strong entity set  b) Weak entity set  c) Identity set  d) Owner set
4. --------- Command is used to delete a database.
   a) Delete database database_name  b) Delete database_name  c) drop database database_name  d) drop database_database_name
5. Which type of below DBMS is MySQL?
   a) Object Oriented  b) Hierarchical  c) Relational  d) Network
6. MySQL is freely available and is open source.
   a) True  b) False
7. --------- represents a “tuple” in a relational database?
   a) Table  b) Row  c) Column  d) Object
8. Communication is established with MySQL using
   a) SQL  b) Network calls  c) Java  d) API’s
9. Which is the MySQL instance responsible for data processing?
   a) MySQL Client  b) MySQL Server  c) SQL  d) Server Daemon Program
10. The structure representing the organizational view of entire database is known as --------- in MySQL database.
    a) Schema  b) View  c) Instance  d) Table

Section-B

(2 Marks)

Answer the following questions

1. Define Data Model and list the types of data model used.
   • A data model that determines the logical structure of a database and fundamentally determines in which manner data can be stored, organized and manipulated.
   • The database technology came into existence in terms of models with relational and object-relational behavior.

Types of Data Model:
   • Hierarchical Database Model
   • Network model
   • Relational model
   • Object-oriented database model

Answer the following questions

1. Answer the following questions
2. List few disadvantages of file processing system.
   - **Data Duplication** – Same data is used by multiple resources for processing, thus created multiple copies of same data wasting the spaces.
   - **High Maintenance** – Access control and verifying data consistency needs high maintenance cost.
   - **Security** – Less security provided to the data.

   - **Single Valued Attributes:**
     - A single valued attribute contains only one value for the attribute and they don’t have multiple numbers of values.
     - **Example:** Age
   - **Multi Valued Attributes:**
     - A multi valued attribute has more than one value for that particular attribute.
     - **Example:** Degree

4. List any two DDL and DML commands with its Syntax.

**Data Definition Language (DDL)**

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATE</td>
<td>Used to create database or tables</td>
<td>CREATE database databasename;</td>
</tr>
<tr>
<td>DROP</td>
<td>Deletes a database or table.</td>
<td>DROP database databasename;</td>
</tr>
</tbody>
</table>

**Data Manipulation Language (DML)**

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSERT</td>
<td>Adds new rows into database table.</td>
<td>INSERT INTO tablename VALUES (value1, value2);</td>
</tr>
<tr>
<td>DELETE</td>
<td>Deletes the records from the table.</td>
<td>DELETE from tablename WHERE columnname=’value’;</td>
</tr>
</tbody>
</table>

5. What are the ACID properties?
**ACID Properties** – The acronym stands for Atomicity, Consistency, Isolation and Durability.

6. Which command is used to make permanent changes done by a transaction?
   - The TCL (Transaction Control Language) command “COMMIT” helps the database to save data permanently.

7. What is view in SQL?
   - **Views** – A set of stored queries.
   - A VIEW in SQL is a logical subset of data from one or more tables.
   - View is used to restrict data access.
8. Write the difference between SQL and MySQL.

<table>
<thead>
<tr>
<th>SQL</th>
<th>MySQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL – Structured Query Language is not a</td>
<td>MySQL is a database management system</td>
</tr>
<tr>
<td>database</td>
<td></td>
</tr>
<tr>
<td>Used to access the database</td>
<td>Allows managing relational databases</td>
</tr>
</tbody>
</table>

9. What is Relationship and List its types.
   - In Entity Relationship Model, relationship exists between two entities.
   - Three types of relationships are,
     1. One-to-One relationship
     2. One-to-Many relationship
     3. Many-to-Many relationship

10. State few advantages of Relational databases.
    ➢ The features of RDBMS are
    - High Availability
    - High Performance
    - Robust Transactions and support
    - Ease of management
    - Less cost

Section-C

Answer the following questions (3 Marks)

1. Explain on Evolution of DBMS.
   - The concept of storing the data started before 40 years in various formats.
   - Punched card technology was used to store the data.
   - The file systems were known as predecessor of database system.
   - Various access methods in file system were indexed, random and sequential access.
   - The file system had more limitations to overcome this DBMS was introduced.

2. What is relationship in databases? List its types.
   - In Entity Relationship Model, relationship exists between two entities.
   - Three types of relationships are,
     - One-to-One relationship
     - One-to-Many relationship
     - Many-to-Many relationship
3. Discuss on Cardinality in DBMS.
   - Cardinality is defined as the number of items that must be included in a relationship.
   - Cardinality is a number of entities in one set mapped with the number of entities of another set via the relationship.
   - Three classifications in Cardinality are one-to-one, one-to-many and Many-to-Many.

![Diagram: Person drives Vehicle]

4. List any 5 privileges available in MySQL for the User.

<table>
<thead>
<tr>
<th>List of privileges available in MySQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select_priv</td>
</tr>
<tr>
<td>Insert_priv</td>
</tr>
<tr>
<td>Update_priv</td>
</tr>
<tr>
<td>Delete_priv</td>
</tr>
<tr>
<td>Create_priv</td>
</tr>
</tbody>
</table>

5. Write few commands used by DBA to control the entire database.
   - The Database Administrator (DBA) uses few commands are known as Administrative MySQL Commands to control the entire database.
     1. **USE Database** – This command is used to select the database in MySQL
     ```sql
     mysql> use test;
     Database changed
     ```
     2. **SHOW Databases** – Lists all the databases available in the database server.
     ```sql
     mysql> show databases;
     ```
     3. **SHOW Tables** – Lists all the tables available in the current database we are working in.
     ```sql
     mysql> show tables;
     ```

Section - D

Answer the following questions: (5 Marks)

1. Discuss on various database models available in DBMS.
   - The database technology came into existence in terms of models with relational and object-relational behavior.
Types of Data Model:

- Hierarchical Database Model
- Network model
- Relational model
- Object-oriented database model

i) Hierarchical Database Model

- Hierarchical database model was IMS, IBM’s first DBMS.
- In this model each record has information in parent/child relationship like a tree structure.
- The collection of records was called as Record Types / Tables.
- The individual records are equal to rows.
- Advantages: Less redundant data, Efficient Search, Data Integrity and Security.
- Limitations: Complex to implement and difficulty in handling many to many relationships.

![Hierarchical Database Model Diagram]

ii) Network model

- Network model is similar to Hierarchical model except that in this model each member can have more than one owner.
- The many to many relationships are handled in a better way.
- This model identified the three database components such as,

  - **Network schema:** Schema defines all about the structure of the database.
  - **Sub schema:** Controls on views of the database for the user
  - **Language for data management:** Basic procedural for accessing the database.
iii) Relational Model

- Oracle and DB2 are few commercial relational models in use.
- Relational model is defined with two terminologies Instance and Schema.
  - **Instance** – A table consisting of rows and columns
  - **Schema** – Specifies the structure including name and type of each column.
- A relation (table) consists of unique attributes (columns) and tuples (rows).

iv) Object-Oriented Database Model

- This model is the combination of **OOP’s concepts and database technologies** and also serves as the base of Relational model.
- Object oriented model uses small, reusable software known as **Objects**.
- These are stored in object oriented database.
- This model efficiently manages large number of different data types.
- Complex behaviors are handled efficiently using OOP’s concepts.
2. List the basic concepts of ER Model with suitable example.

- ER model consists of a collection of entities where each of these entities will be interconnected with each other with conditions and dependencies.

**ER Modeling Basic Concepts**

The basic concepts of ER model consists of

1. **Entity or Entity type**
2. **Attributes**
3. **Relationship**

**Entity or Entity type**

An Entity can be anything a real-world object or animation which is easily identifiable by anyone even by a common man.

An entity is represented by a rectangular box.

**Example:** In a company’s database Employee, HR, Manager are considered as entities

![Employee and Manager](image)

**Types of Entity:**

- **Strong Entity:**
  - A Strong entity is the one which doesn’t depend on any other entity on the database with a primary key
  - It is represented by one rectangle.

- **Weak Entity:**
  - A weak entity is dependent on other entities and it doesn’t have any primary key.
  - It is represented by double rectangle.

![Exam, Subject, Pass/Fail, Marks](image)

- **Entity Instance:**
  - Instances are the **values** for the entity
  - Entity Instance denotes the category values for the given entity.
  - If we consider animals as the entity their instances will be dog, cat, cow… Etc
### Attributes

- An attribute is the information about that entity and it will describe, quantify, qualify, classify, and specify an entity.

### Types of attributes:

1. **Key Attribute** - Unique characteristic of an entity.
2. **Simple Attributes** - Cannot be separated
3. **Composite Attributes** - Can be subdivided into simple attributes
4. **Single Valued Attribute** - Contains only one value
5. **Multi Valued Attribute** - Has more than one value

### Relationship:

- In Entity Relationship Model, relationship exists between two entities.
- Three types of relationships are,
  - One-to-One relationship
  - One-to-Many relationship
  - Many-to-Many relationship

### 3. Discuss in detail on various types of attributes in DBMS.

**Attributes**

- An attribute is the information about that entity and it will describe, quantify, qualify, classify, and specify an entity.
- An attribute will always have a single value, that value can be a number or character or string.

**Types of attributes:**

1. Key Attribute
2. Simple Attributes
3. Composite Attributes
4. Single Valued Attribute
5. Multi Valued Attribute

- **Key Attribute**
  - A key attribute describes a unique characteristic of an entity.
### Simple Attribute
- The simple attributes cannot be separated it will be having a single value for their entity.

#### Example:
Name is the attribute for the entity employee and here the value for that attribute is a single value.

### Composite Attributes
- The composite attributes can be subdivided into simple attributes without change in the meaning of that attribute.

#### Example:
In the above diagram the employee is the entity with the composite attribute Name which are sub-divided into two simple attributes first and last name.

### Single Valued Attributes:
- A single valued attribute contains only one value for the attribute and they don’t have multiple numbers of values.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age</td>
<td>3</td>
</tr>
<tr>
<td>Roll no</td>
<td>85</td>
</tr>
</tbody>
</table>

#### Example: Age- It is a single value for a person as we cannot give n number of ages for a single person

### Multi Valued Attributes:
- A multi valued attribute has more than one value for that particular attribute.

#### Example: Degree - A person can hold n number of degrees so it is a multi-valued attribute.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree</td>
<td>B.Tech, MBA</td>
</tr>
<tr>
<td>Bank_Account</td>
<td>SBI, HDFC</td>
</tr>
</tbody>
</table>

4. Write a note on open source software tools available in MySQL Administration.

**MySQL Administration open source software tools**
- Many open source tools are available in the market to design the database in a better and efficient manner.
- PhpMyAdmin is most popular for Web Administration.
• The popular Desktop Application tools are MySQL Workbench and HeidiSQL.

**PHPMYADMIN (Web Admin)**

• This administrative tool of MySQL is a web application written in PHP.
• They are used predominantly in web hosting.
• The main feature is providing web interface, importing data from CSV and exporting data to various formats.
• It generates live charts for monitoring MySQL server activities like connections, processes and memory usage.
• It also helps in making the complex queries easier.

**MySQL Workbench (Desktop Application)**

• It is a database tool used by developers and DBA’s mainly for visualization.
• This tool helps in data modeling, development of SQL, server configuration and backup for MySQL in a better way.
• Its basic release version is 5.0 and is now in 8.0 supporting all Operating Systems.
• The SQL editor of this tool is very flexible and comfortable in dealing multiple results set.

**HeidiSQL (Desktop Application)**

• This tool helps in the administration of better database systems.
• It supports GUI (Graphical User Interface) features for monitoring server host, server connection, Databases, Tables, Views, Triggers and Events.

5. **Explain in detail on Sub Queries with suitable examples.**

• The SQL query is written within a main Query is called as Nested Inner/ SubQuery.
• The sub query is executed first and the results of sub query are used as the condition for main query.

**The sub query must follow the below rules:**

- Sub Queries are always written within the parentheses.
- Always place the Subquery on the right side of the comparison operator.
- ORDER BY clause is not used in sub query, since Subqueries cannot manipulate the results internally.
- Consider the **Employee** table with the fields EmpID, Name, Age and Salary.
Using Select statement the sub query is,

```sql
SELECT * from Employee where EmpID IN (SELECT EmpID from Employee WHERE Salary < 20000);
```

- First, the inner query is executed.
- As a result EmpID 101 and 103 are retrieved.
- Now the external or outer query is executed.
- Internally the query is,

```sql
SELECT * from Employee where EmpID IN(101,103)
```

- And the output is,

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Name</th>
<th>Age</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Ram</td>
<td>35</td>
<td>15000</td>
</tr>
<tr>
<td>102</td>
<td>Gopal</td>
<td>41</td>
<td>30000</td>
</tr>
<tr>
<td>103</td>
<td>Priya</td>
<td>32</td>
<td>13000</td>
</tr>
<tr>
<td>104</td>
<td>Hari</td>
<td>37</td>
<td>20000</td>
</tr>
</tbody>
</table>

- Similarly the subqueries are used with INSERT, UPDATE and DELETE.

**PREPARED BY**

J. BASKARAN M.Sc., B.Ed. (C.S)  
jbaskaran89@gmail.com

J. ILAKKIA M.Sc., M.Phil., B.Ed. (C.S)  
jilakkia@gmail.com